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Introduction

The present document should allow everyone to get acquainted with the use of 
vzly.py,  the Python script for Salome developed in the context of the study of 
vortex generators using the CFD solver Edge available from:

https://rapidshare.com/files/4063353391/vzlu.py (in September 2011).

This script allows to:

• Generate prismatic layer geometries   around airfoils.

• Export meshes   in the format of Edge.

• Generate jBAY input files   to use in Edge.

This document is divided into three parts:

• The first part gives all the  basic information about the use of Edge and the 
use of the vortex generator models implemented in this solver (pages 2 to 12).

• The second part consists in a tutorial (pages 13 to 30) showing all the steps of 
the generation of a mesh and of the generation of a jBAY input file with Salome. 

• The third part (pages 31 to 35), consists in a deeper explanation of the use of 
the  function  pl(  ) which  permit  to  create  quickly  in  Salome  prismatic  layer 
geomerties.

In  addition,  two examples  of  jBAY and RANS input  files are  given  in  the 
annexes.

This document was written in the context of the validation of the jBAY and the 
RANS  vortex  generator  models  in  Edge,  the  CFD  solver  developed  by  the 
Swedish Research Defense Agency (FOI), that I made in the Czech Research and 
Test Institute of Prague (VZLU) during my final internship as a student in the 
Institut Polytechnique des Sciences Avancées of Ivry-sur-Seine (IPSA) in France 
and that took place during the summer 20111.

1 Tougeron, W., “Validation of Vortex Generator Models in Edge” ; available from http://www.fichier-
pdf.fr/2011/09/10/validation-of-vortex-generator-models-in-edge/validation-of-vortex-generator-models-in-edge.pdf 
(in September 2011).
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I Edge Use
This part gives basic information for future users of Edge, and also deals with the use of the jBAY 
and the RANS vortex generator models in this solver.

I.1  Edge Basic Use

I.1.1  Single Processor Calculation

The serial processing version of Edge is available from the website of FOI2. Despite this version 
doesn't permit parallel computations, it allows to use all the Edge's tools as the vortex generator 
models seen in this document.

I.1.1.1  The Inputs

To run Edge, the user have first to put into a folder two crucial files:

• an “input file” having the extension .ainp, generally called “Edge.ainp”.

• and a “mesh file” having the extension .bmsh, generally called “Edge.bmsh”.

The  input  file  is  the  one  which  contains all  the  input  variables:  free-stream  velocity,  initial 
temperature, parameters of the turbulent model, number of grids for multigrid and so on. This file 
has to be copied from a  template file  or  can be  generated with Xedge,  the  graphical interface of 
Edge. But it is also possible to manually modify the variable values directly into the input file.

The few variables to know at the beginning are summed up in the next table:

Variable name in the input file Signification

CFL Current number.

INPRES
If equals 0, the calculation start from scratch. If equals 2, 
the calculation start from the last computational data.

ITMAX Maximum number of iterations for the finest grid.

NFMGCY
Maximum number of iterations for grids other than the 
finest grid.

NGRID Number of grids for multigrid.

NPART Number of processors for parallel computation.

RESRED Residual convergence criteria for finest grid.

RMU Viscosity of the fluid.

TURB_MOD_NAME Name of the turbulent model.

UFREE, VFREE, WFREE u, v and w components of the free stream velocity.

Table 1: Basic variables to modify in the Edge input file.

With time, the user becomes more and more familiar with the name of the Edge input variables.

I.1.1.2  Mesh Files

The mesh file can be obtained from a .cgns file, generated for example with Icem,  thanks to the 
command “cgns2ffa” in a linux terminal, as shown in the following figure.

2 From http://www.foi.se/FOI/templates/Page____5410.aspx (in September 2011).
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I Edge Use - Edge Basic Use

Illustration 1: Edge command to convert a CGNS mesh into a FFA mesh readable by Edge.

I.1.1.3  The “bound” Command

Once this two files are available, the user can specify the boundary condition types, typing the 
command  “bound”  (without  argument).  A  new  file  is  then  created,  containing  the  boundary 
condition types, called for example “Edge.aboc” (the name of all files used by Edge can be modify 
in the input file – even if using generic names can accelerate the use of Edge and the sharing of 
results ; see the Appendix A.1 of the User Guide3 to know what variables are associated with these 
names).

I.1.1.4  The “preprocessor” Command

Then, the user have to prepare the mesh to make it readable by the processor(s) using the command 
“preprocessor” followed by the name of the input file. This command reorders the nodes and the 
edges,  creates the  coarser  meshes for multigrid  and  so on,  storing the whole in  a  .bedg  (e.g. 
“Edge.bedg”).

I.1.1.5  The Edge Launch

Finally,  the user can launch the calculation by using the command “edge_run”  followed by the 
name of the input file. During the calculation and at the end of it, the user get back the results in 
a .bout file (e.g.  “Edge.bout”).  In addition,  at  the end of the computation can be generated an 
other .bout file, called usually “Post_Edge.bout” which additional contains data like the y+.

All this algorithm is summed up in the following picture.

Illustration 2: Sum up of files used and generated during a classical use of Edge.

3 “Edge User Guide”, FOI dnr 03-2870 , March 2007, p. 67 ; available form 
http://www.foi.se/upload/projects/edge/documentation-latest/edge-user.pdf (in September 2011).
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I Edge Use - Edge Basic Use

I.1.1.6  Post Processing

Then, the user can convert the .bout files into .cgns file or Ensight Gold files, using respectively the 
command “ffa2cgns” or “ffa2engold” followed by the name of the mesh file, then by the one of 
the .bout file, and then by the name of the created file in the new format (.cgns or Ensight Gold), as 
shown in the following picture.

Illustration 3: Export of post processing data into a Engold case.

I.1.2  Multiprocessor Calculation

The work of Edge in parallel is possible only if the user is a partner of the FOI in the Edge develop-
ment, giving full access to the Edge sources. This partnership can be asked by contacting directly 
the FOI4.  So, this part can only interest people who have access to this full version of Edge. The 
other ones can jump to the page 6 and continue by the read of the chapter I.2.

I.1.2.1  The Input Variable NPART

For the case of multiprocessor calculation, the algorithm is the same, excepting that the command 
“preprocessor” give birth to several .bedg files, as many as there are processors involved. 

The user has first to create a “machines” file, containing the host name of the servers to be used and 
the number of processors they contain as shown in the next picture. In the case of several servers, 
the user should use one line for each server in the “machines” file. The command to launch the 
calculation is then “edge_mpi_run” followed by the name of the machine file, the name of the input 
file and the number of processors to use, as shown in the next picture.

4 From http://www.foi.se/FOI/templates/Page____4567.aspx (in September 2011).
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I Edge Use - Edge Basic Use

Illustration 4: Changing in the Edge use process when dealing with a multiprocessor calculation.

I.1.2.2  The “merge_partitions” Command

In the case of serial computation (with one processor), the user can stop the computation at any 
time, even if the convergence criteria isn't reached yet, using, for example, the command [Ctrl]+[C] 
in the shell terminal in which he or she launched the computation. Doing this, the Post_Edge.bout  
isn't generated, but the last Edge.bout file is ready to be converted into a .cgns or Ensight Gold file. 
With  parallel  computation,  if  the  user  stops  the  calculation  before  the  convergence  criteria  is 
satisfied, he or she has to deal with several Edge.bout_p* files, that cannot be directly converted 
into .cgns or Ensight  gold files.  The user has first  to “merge” these files,  using the command 
“merge_partitions” followed by the name of the input file as shown in the next picture.

Illustration 5: Manual merge of intermediate post-processing data in the case of multiprocessor calculation.

Knowing all of this, a user should be quickly able to use Edge for basic case studies.
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I Edge Use - Edge Use with Vortex Generator Models

I.2  Edge Use with Vortex Generator Models
Let's now see how to use the vortex generator models implemented in Edge. To do so, the user has 
first to change the value of the variable “VGCONFIG” in the input file to “1” and to replace the  
value of “CFVGNAME” with the name of another “input file” giving the definition of the vortex 
generators (e.g. “Edge.avg”). The set up of this input file depends on the model the user wants to 
use. When reading this file, Edge automatically recognize if the model chosen by the user is the 
jBAY model or the RANS model.

I.2.1  The jBAY Model

I.2.1.1  The jBAY Input File

To use the jBAY model, the vortex generator input file has just to respect the following syntax:
VGENDATA N 0 0 1 

      region N 0 0 1 
            VGENCONFIG N 0 0 i 
                  VGEN N 0 0 3
                        coord DI 3 n1 0 
                              X1 X2 … Xn1

                              Y1 Y2 … Yn1

                              Z1 Z2 … Zn1

                        norm DI 3 n1 0 
                              A1 A2 … An1

                              B1 B2 … Bn1

                              C1 C2 … Cn1

                        height DI 1 n1 0 
                              h1 h2 … hn1

with:

i The number of vanes to use.

n1, n2, ... and ni
The number of  points  describing a vane  (n1 can be  different 
from n2, n3, and so on).

X1, X2, ... and 
Xn1

All the x-coordinates of the points 1, 2, … and ni describing a 
vane.

Y1, Y2, ... and 
Yn1

_____   y-coordinates  _________________________________
____ .

Z1, Z2, ... and 
Zn1

_____   z-coordinates  _________________________________
____ .

A1, A2, ... and 
An1

All the x-coordinates of the normals 1, 2, … and ni describing a 
vane.

B1, B2, ... and 
Bn1

_____  y-coordinates  _________________________________
____.

C1, C2, ... and 
Cn1

_____  z-coordinates  _________________________________
____.

h1, h2, ... and hn1
All the heights of a vane associated with the points and normals 
1, 2, … and ni describing a vane.

Table 2: Input parameters describing vortex generators in a jBAY input file.

Notice that the indentation isn't important for Edge, but the file must not contain any tabulation. 
Indeed, only classical spaces must be used otherwise the file won't be ridden by Edge.
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I Edge Use - Edge Use with Vortex Generator Models

One can remark that the arbitrary constant included in the jBAY model (CVG) doesn't appear in this 
file. This is because, according to Adam Jirásek, the jBAY model is totally independent from this 
constant5 which is already defined in the jBAY model implementation (CVG=10)6.

Let's see  now  precisely what points, normal and heights are in question here.  The next picture 
shows an example of vortex generator vane positioned on a wing. One can see into the second part 
of this picture the three points (red  bullets) and the three associated vectors (blue arrows) neces-
sary to describe it. The heights are just the height of the vane at these point positions, as illustrated 
in the last part of this picture.

a) 

b)                                         c)    

Illustration 6: a) A vane laying on a wing. b) Vane points and normals to describe this vane in a jBAY input file. c)  
Heights to describe this vane in a jBAY input file.

Notice that a function provided in the script vzlu.py permits to automatically generate such files by 
the use of Salome. And, a tutorial showing how to use this tool is given in the part II page 13.

5 Jirásek, A., “Vortex-Generator Model and Its Application to Flow Control”, Journal of Aircraft, Vol. 42, No. 6, April 
2005, p. 1486.

6 “Edge Theoretical Formulation”, FOI dnr 03-2870 , March 2007, p. 56 ; available from 
http://www.foi.se/upload/projects/edge/documentation-latest/edge-theory.pdf (in September 2011).
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I Edge Use - Edge Use with Vortex Generator Models

I.2.1.2  The Preparation of the .bedg Files to Use the jBAY Model

Once the jBAY input file is ready and the .ainp file is modified, the user has to modify the .bedg 
file(s) before launching the calculation.

To do so, he or she has to execute, after the command “preprocessor”, the command “VG_identify” 
followed by the name of the Edge input file (e.g. “VG_identify Edge.ainp”).

I.2.2  The RANS Model

I.2.2.1  The Vortex Generator Input File for the jBAY Model

As well as for the jBAY model, to use the RANS model in Edge, the vortex generator input file has  
to follow the RANS model syntax. But let's first see how vortex generators are defined according to 
the RANS model in Edge. 

The following picture illustrates the organization of vortex generator vanes according to the RANS 
model in Edge. All the vanes are grouped into pairs, and positioned around “wall points” that are in 
the middle of virtual lines linking their trailing edges. Between two defined vortex generator pairs, 
additional pairs can be interpolated as the ones appearing in light gray.

Illustration 7: Vortex generator vane pair organization in the RANS model.

Each pair of vane is defined by its wall point position, its height, its gap, the angle of attacks of its  
vanes,  its  chord  distribution,  an  approximative  wing normal  at  its  position,  the  approximative 
incoming flow direction at its position and the distance between it and the other vane pairs.

The syntax of a RANS input file is:

8
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I Edge Use - Edge Use with Vortex Generator Models

VGENDATA N 0 0 1 
      region N 0 0 1 
            VGENCONFIG N 0 0 1 
                  RANS-VGEN N 0 0 17
                        ninterwall I 1 1 0 
                              ninterwall
                        npoint I 1 1 0 
                              64 
                        nperiod I 1 1 0 
                              20 
                        ncolloc I 1 1 0 
                              10 
                        heightscale DI 1 i 0 
                              heightscale1 …  heightscalei

                        r0 DI 1 i 0 
                              r01 r02 … r0i 
                        c0 DI 1 i 0 
                              c01 c02 … c0i

                        c1 DI 1 i 0 
                              c11 c12 … c1i 
                        alphal DI 1 i 0 
                              α11 αl2 … αli

                        alphar DI 1 i 0 
                              αr1 αr2 … αri

                        dist DI 1 i 0 
                              dist1  dist2 … disti

                        delta DI 1 i 0 
                              Δ1  Δ2 … Δi

                        dvector DI 3 i 0 
                              I1 I2 … Ii

                              J1 J2 … Ji

                              K1 K2 … Ki

                        coord DI 3 i 0 
                              X1 X2 … Xi

                              Y1 Y2 … Yi

                              Z1 Z2 … Zi

                        norm DI 3 i 0 
                              A1 A2 … Ai

                              B1 B2 … Bi

                              C1 C2 … Ci

                        height DI 1 i 0 
                              h1  h2 … hi

                        g_params DI 2 1 0 
                              0.500000  0.500000

with:

i
The number of vane pairs to define (excluding the interpolate 
pairs).

ninterwall The number of interpolated pairs between two defined pairs.

heightscale
A coefficient  giving  the  distance  above  the  vortex  generator 
vane pair in which this pair has an influence. (See the picture 8 
below to have more explanation.) Its default value is 4.

r0

The Lamb-Oseen vortex core radius as defined in the chapter 
Error: Reference source not found page Error: Reference source
not found of this document divided by the height of the vanes. 
Its default value is 0.1.
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I Edge Use - Edge Use with Vortex Generator Models

c0 and c1

Two coefficients  defining the  chord  distribution of  the  pair's 
vanes. c0 defines how many times the max chord of the vanes is 
higher than the vanes' height. c1 defines the slope of the vanes' 
chord.  (See  the  table  4 on  the  next  page  to  have  more 
explanation.)

α0 and α1

The angles, in degrees, of the left and right vane of the pair.  
Each of them can have a different angle of attack. The positive 
rotation direction is defined by the wing normal  at  the pair's 
position.  (See  the  picture  9 on  the  next  page  to  have  more 
explanation.)

dist and Δ

Two quantities defining the gap between vanes.  dist  represents 
the distance between a pair and the other pairs divided by the 
height of the vane pair.  Δ represents the distance between the 
edges of the vanes of the pair at the wall point position. (See the 
picture 10 on the next page to have more explanation.)

I, J and K
Coordinates  of  a  vector  very  approximately  parallel  to  the 
incoming flow (e.g. 1,0,0).

X, Y and Z
Precise  coordinates  of  the  wall  point  of  the  pair.  (See  the 
previous picture 7 to have more explanation.)

A, B and C
Coordinates of a vector very approximately perpendicular to the 
wing at the vane pair's position (e.g. 0,1,0).

h Maximum height of the pair's vanes.

Table 3: Input parameters describing vortex generators in a RANS input file.

One can notice that some parameters are here ignored, as “npoint” or “ nperiod”. This is because 
these parameters are mathematical parameters and that they have no geometrical meaning. And, as 
it is impossible for a user to know how to calibrate these parameters without a long and complex  
study, the best is to let their default values.

Notice that, for a 2D calculation, the both vanes can be out of the 2D computing plane, but the wall 
points should be in this plane. Then, the presence of the other vane pairs can be represented by the  
use of the parameter dist.

Illustration 8: RANS model heightscale definition.
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I Edge Use - Edge Use with Vortex Generator Models

c1 Vanes' shape

1

0.7

0

Table 4: Influence of c0 on the shape of vanes in the RANS model.

Illustration 9: Direction of vanes' angles in the RANS model.

Illustration 10: Definition of dist and Δ in the RANS model.

I.2.2.2  The Preparation of the .bedg Files to Use the RANS Model

As for the jBAY model, once the .ainp file is modified and the command “preprocessor” executed, 
the user has to modify the .bedg file(s) before launching the calculation.

But  in  the case of  a  2D calculation,  the user  has  first  to  allow non zero components in  the  z 
direction. To do so, he or she has to use the command “transform_2_5D” followed by the name of 
the .ainp input file and by the angle, in degrees, of the computational plane extrusion (usually, 0, 
that is a perpendicular extrusion). As visible in the next picture, showing a purely 2D calculation 
and a “2.5D” calculation, this action doesn't affect the results precision and a post-processing data 
from a purely 2D and a “2.5D” calculation are completely comparable.
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Illustration 11: Comparison between lift curves obtained thanks to a purely 2D case and a 2.5D case.

Then, the user has to execute the command “VG_identify” followed by the name of the Edge input  
file, before launching the computation.
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II Salome Tutorial
This part consists in a tutorial showing how to prepare a 3D unstructured mesh with a structured 
prismatic layer around an airfoil and how to generate a jBAY input file for Edge using Salome and 
the script vzlu.py 

The considered geometry for this tutorial is a NACA 5410 airfoil of which point coordinates are 
provided below.

1.00000000 0.00000000
0.99748513 0.00077361
0.98944828 0.00306820
0.97613899 0.00680467
0.95768566 0.01185597
0.93426817 0.01805318
0.90611775 0.02519335
0.87351622 0.03304818
0.83679466 0.04137286
0.79633125 0.04991438
0.75254842 0.05841898
0.70590920 0.06663856
0.65691310 0.07433610
0.60609147 0.08129048
0.55400236 0.08730097
0.50122500 0.09219185
0.44835366 0.09581735
0.39592429 0.09806411
0.34380117 0.09833224
0.29340734 0.09626546
0.24537867 0.09200881

0.20032140 0.08579010
0.15879826 0.07790949
0.12131625 0.06872426
0.08831700 0.05862930
0.06017044 0.04803467
0.03717172 0.03734141
0.01954131 0.02691747
0.00742726 0.01707534
0.00090878 0.00805305
0.00000000 0.00000000
0.00456933 -0.00668443
0.01442514 -0.01167960
0.02940217 -0.01504568
0.04928282 -0.01688310
0.07380416 -0.01733146
0.10266600 -0.01656783
0.13553893 -0.01480426
0.17207113 -0.01228380
0.21189335 -0.00927458
0.25462133 -0.00606174
0.29985602 -0.00293692

0.34718184 -0.00018572
0.39616401 0.00192636
0.44711788 0.00354839
0.49877500 0.00502783
0.55052610 0.00625532
0.60182022 0.00715010
0.65210389 0.00766598
0.70082745 0.00779164
0.74745158 0.00754796
0.79145400 0.00698296
0.83233595 0.00616502
0.86962861 0.00517542
0.90289925 0.00410086
0.93175723 0.00302685
0.95585980 0.00203218
0.97491752 0.00118496
0.98869932 0.00053993
0.99703677 0.00013686
1.00000000 0.00000000

This airfoil was generated thanks to the useful java applet available on the web and called JavaFoil7 
with the following parameters:

Number of Points 61

Thickness t/c 10 %

Camber f/c 5 %

Camber Location xf/c 40 %

Then, the .igs file was generated thanks to this applet and named “naca5410.igs”.

To accelerate the mesh generation, the domain radius is here reduced to 10 chords.

Each step is followed by a helping text describing precisely how to complete it or making some 
remarks to explain the aim of actions to be followed.

7 Available from http://www.mh-aerotools.de/airfoils/javafoil.htm (in August 2011) ; Note that, thanks to this applet, 
the user can directly past point coordinates in the “Coordinates” window and generate an .igs file without using any 
parameter.
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II Salome Tutorial - Creation of the Geometry

II.1  Creation of the Geometry

II.1.1  Import of the Basis Geometry

1. Open Salome.

2. Create a new study.

File → New or [Ctrl]+[N]

Warning: From  this  point,  save  regularly  your  work  by  
clicking on the “Save” icon of the toolbar or by using [Ctrl]+[S].

3. Load the “Geometry” module.

Click on  in the toolbar.

4. Import the file “naca5410.igs”.

File → Import or [Ctrl]+[I]

Then, change the “Files of type” for “IGES Files ( *.iges *.igs )” and 
double click on the file “naca5410.igs”.

Warning: Choose “No” when a prompt windows asks if the units  
have to be taken into account.

5. Expand the object “Geometry” in the study tree.

Double-click on the “Geometry” icon in the study tree on the left-hand 
side  of  the  Salome  window  .  An  object  called 

“S_1(0)” should be now visible.

6. Enlarge the study tree column.

Hold the right  click  on  the  right  border  of  the  study tree  column's 
header “Name” and displace it to the right.

7. Auto-fit the geometry.

Right click “Fit all” button of the 3D window toolbar . 

8. Manipulate the 3D window to familiarize with it.

Rotate, translate, and zoom thanks to [Ctrl] and, respectively, the right 
click, the middle click, and left click of the mouse.

Zoom is also possible with the mouse roll.

Rotate perpendicularly to the screen plane by positioning the cursor far 
from the middle of the 3D window before beginning the rotation.

9. Look into the   O  xy   direction  .

Position  the  cursor  on  the  “Front”  icon  of  the  3D window toolbar 

 then hold the right button of the mouse until other icons appear. 

Then, choose the “Top” view .

14



II Salome Tutorial - Creation of the Geometry

10. Deactivate the axis display.

Click on the “Show/Hide trihedron” of the  3D window toolbar .

II.1.2  Generation of the Prismatic Layer Geometries

11. Load the “vzlu.py” script.

File → Load Script or [Ctrl]+[T]

The file “vzlu.py” is given in the annex  Error: Reference source not
found, page Error: Reference source not found.

12. Launch the prismatic layer generation   on the imported airfoil   
with a prismatic layer thickness of 0.02 meters.

Type in the “Python Console” at the bottom of the Salome window:

pl(0.02,'S_1(0)')

13. Read the error message in the Python console.

The prismatic layer geometry generation failed. This is due to a wrong 
closure of the airfoil which often appears. After importing an .igs file,  
it is recommended to check its continuity at the trailing edge and the 
leading edge. We will now reconstruct a closed airfoil.

14. Explode the airfoil   into edges  .

Select the airfoil (in the study tree or the 3D window) then:

New Entity → Explode

Change the “Sub Shapes Type” into “Edge” then click on “Apply and 
Close”.

Warning: Confirm the operation in the prompt window.

15. Expand the airfoil object in the study tree.

Under this object are now visible all the edges which was contained in 
it.

16. Collapse the airfoil object in the study tree.

Double click once again on the airfoil's icon in the study tree to hide 
the exploded edges.

17. Hide the   airfoil  .

Right click on the airfoil's icon in the study tree and select “Hide” in  
the prompt menu.

Warning: This action doesn't hide the exploded edges but just the  
airfoil itself.

18. Zoom strongly on the trailing edge to see the discontinuity.
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19. Delete the lower edge of the airfoil touching the trailing edge.

Select the edge and use [Delete].

20. Construct a new edge to replace it.

New Entity → Build → Edge

Then,  click  on  the  two  boundary  points  and  click  on  “Apply  and 
Close”.

21. Auto-fit the whole airfoil.

22. Build a new wire   containing all the present edges  .

Select all the edges (in the 3D window or in the study tree), then:

New Entity → Build → Wire

and click on “Apply and Close”.

A new  airfoil  is  now  constructed,  on  which  we  will  execute  the 
automatic prismatic layer generation. But before, we will create a point 
which  will  permit  to  “cut”  the  wing airfoil  so as  to  create  enough 
“intermediate edges” in the prismatic layer geometry.

23. Create a point   at the location (0,0,0)  .

New Entity → Basic → Point

Then, click on “Apply and Close”.
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24. Launch the prismatic layer geometry generation    on the new   
wire using the created point as a “start point”.

Type in the Python console:

pl(0.02,startPoint=True)

This time, the name of the airfoil is not given in the arguments of the  
function pl( ). This is because the default name of the airfoil in this 
function  is  “Wire_1”,  that  is  the  same name than  the  wire  we just 
created.

25. Expand the  object  “Wire_1  0.0200  PL geometries”  in  the 
study tree.

Under this object are now visible all the geometrical object necessary 
to create a prismatic layer, as we will see8.

II.1.3  Creation of the 2D Domain Geometry

26. Create a disk   of radius 10 meters  .

New Entity → Primitives → Disk

Then, change the “Radius” for 10, the “Orientation” for “OXY” and 
click on “Apply and Close”.

27. Auto-fit the whole geometry.

28. Cut the disk   with the wing airfoil  .

Select the disk, then:

Operations → Boolean → Cut

then  select  the  face  called  “airfoil”  under  the  object  automatically 
generated by the pl( ) function (“Wire_1 0.0200 PL geometries”) and 
click on “Apply and Close”.

29. Explode the cut disk   into a single face  . 

Select the new object called “Cut_1”, then:

New Entity → Explode

then change the “Sub Shapes Type” for “Face” then click on “Apply 
and Close”.

30. Expand the object “Cut_1” in the study tree.

The object “Face_1” is now visible.

8 More information about the pl( ), see the part III, page 31.
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II.1.4  Creation of the 3D Domain Geometry

Warning: The following operations are crucial and demand some  
particular attention.

31. Extrude  all these objects    in the    z   direction with a symmetric   
length  of  0.025  meters:  “Face_1”,  “intermediateEdge0”  and 
“...1”, “offset0” and “...1”.

Select all these objects (by preference in the study tree), then:

New Entity → Generation → Extrusion

then select the third icon on the top of the prompt window  , 

change “Dz” for 0.025, select “Both Directions” and click on “Apply 
and Close”.

After that, a new volume should be visible in the study tree (with the  
name  “Extrusion_1”,  for  example),  as  well  as  new  extruded  faces 
(named “Extrusion_1”, “...2”, and so on).

32. Partition the  new extruded volume “Extrusion_...”    with  the   
new extruded faces “Extrusion_...”.

To do so, select the volume to partition, then:

Operation → Partition

then click on “Tool Objects” and select all the faces (for example in the 
study tree). Change “Resulting Type” for “Solid” and click on “Apply 
and Close”.

Warning: The partitioning operation can take a long time.

After that, a new object called “Partition_1” should be visible in the 
study tree. This object is our final 3D domain. It is then comfortable to 
continue with a cleaned study. To do so, it is possible to export this 3D 
domain and to import it in a new study.

33. Export the object “Partition_1”   into a .brep file  .

Select the object “Partition_1”, then:

File → Export

34. Create a new study.

File → New or [Ctrl]+[N]

35. Load the “Geometry” module.

Click on .

36. Import the .brep file.

File → Import or [Ctrl]+[I]

37. Expand the object “Geometry” in the study tree.

38. Look in the O  xy   direction   and deactivate the axis display.
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II.1.5  Creation of the Domain's Groups

39. Hide everything in the 3D window.

Left click in the 3D window, then select “Hide All”.

40. Open the “Create Group” window   from the domain object  .

Left click on the domain object in the study tree (“Partition_1.brep_1”) 
and select “Create Group”.

41. Select the edge mode.

Select  the  second  icon  on  the  top  of  the  “Create  Group”  window 

.

42. Create the group called “Inter”   containing all the intermediate   
edges of the prismatic layer.

Change the “Name” for “Inter”. Then, in the 3D window, zoom on all  
the  intermediate  edges  (cf.  Picture  below),  select  them  and 
progressively  add  them into  the  group  window by  clicking  on  the 
button “Add”.

     

Warning: In the study tree the key to select several items is [Ctrl],  
but in the 3D window this key is [Shift].

Warning: Don't  hesitate  to  use  selection  boxes  to  select  edges  
when its difficult to select them by a simple click.

When all the intermediate edges are added in the group window, click 
on “Apply”.

43. Expand the domain object in the study tree.

The group “Inter” is now visible. To modify this group afterwards, left  
click on it and select “Edit”.

44. Create  another   group    with  the  transversal  edges  called   
“Trans”.
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45. Create  two  other   groups    with  the  transversal  edges  of  the   
prismatic  layer  called  “LongUp”  and  “LongDown”  ,  as   
illustrated in the following picture.

     

46. Create  two other   groups,    each off which contains one of the   
two farfield edges, and called “FarfFront” and “FarfBack”.

Warning: The following operation is  crucial  and demand some  
particular attention.

47. Create  a group   containing the transversal edge of the farfield   
surface,  as  illustrated  in  the  next  picture,  and  call  it 
“FarfTrans”.

     

48. Close the “Create Group” window.

49. Check if all the groups are present in the study tree and if there 
is no mistake.

50. Hide everything in the 3D window.

51. Open the “Create Group” window   from the domain object  .

52. Select the surface mode.

53. Create  a group    containing the main surface of the domain's   
front  , as illustrated in the next picture, and call it “MainFront”  .
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54. Create  another  group    containing  the  main  surface  of  the   
domain's back and call it “MainBack”.

55. Hide everything in the 3D window.

56. Select the volume mode.

57. Create  a  group    called  “PL”  containing  the  two  volumes   
forming the prismatic layer.

At  this  stage,  all  the  groups  necessary  to  define  the  geometrical 
parameters of the mesh are created. It is then necessary to create the 
groups which will be exported with the mesh in the .amsh file.

58. Hide everything in the 3D window.

59. Select the face mode.

60. Create  all  the  groups  to  export  with  the  mesh:  “wing”, 
“farfield”, “front” and “back”.

Warning: The group “wing” should contain two faces: the upside  
and the downside of the wing.

Warning: The “front” and “back” groups should contain three  
faces:  the  main  face  and  two  other  faces  from  the  
prismatic layer geometry.

61. Close the “Create Group” window.

62. Display each group     separately     in the shading mode   and   check   
if there is no mistake.

Left click on a group and select “Show Only”, then left click in the 3D 
window and select:

Display Mode → Shading
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II.2  Generation of the Mesh

II.2.1  Prismatic Layer Meshing

63. Load the “Mesh” module.

Click on the “Mesh” icon  in the main toolbar.

64. Create a void mesh   on the domain geometry  .

Select the domain geometry in the study tree, then

Mesh → Create Mesh

then click  on “Apply and Close”  without  changing anything in  the 
prompt window.

65. Expand the object “Mesh” in the study tree to make appear the 
new mesh “Mesh_1”.

Double-click on the “Mesh” icon in the study tree .

Warning: The following operations are crucial and demand a lot  
of attention!

66. Open  the “Create sub-mesh” window    from this     mesh to start   
the creation of a new sub-mesh.

Select the object “Mesh_1” in the study tree, then:

Mesh → Create Sub-mesh

Associate the sub-mesh with     the group “Inter”  .

Click on the arrow button in front of “Geometry” and then select the 
group “Inter” in the study tree.

Warning: If a prompt menu appears when clicking on the arrow  
button, select “Direct geometry selection”.

67. Change the “Name” of the sub-mesh   for “Inter”  .

68. Change the  1D  “Algorithm”  of  this  sub-mesh    for  “Wire   
discretisation”.

In the tab “1D”, change the “Algorithm” for “Wire discretisation”

69. Add an hypothesis of type “Nb. Segment” to this sub-mesh.

Click  on  the  icon   in  front  of  “Hypothesis”  and  select  “Nb. 
Segment”.

70. Change the “Name” of this hypothesis   for “Inter”  .

71. Change the “Number of Segments”   for 30  .

72. Change the “Type of distribution”   for “Scale distribution”  .

73. Change the “Scale Factor”   for 300  .
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74. Apply the changes to the hypothesis and sub-mesh.

Click  on  “OK” to  quit  the  “Hypothesis  Construction”  window and 
“Apply and Close” to close the “Create sub-mesh window”.

75. Expand the object “Hypotheses” in the study tree.

The hypothesis newly created is now visible.

76. Generate the mesh “Mesh_1”.

Select the mesh “Mesh_1” in the study tree, then:

Mesh → Compute

After few seconds, a prompt window gives a sum up of the generated 
mesh. Click on “Close to quit this window.

77. Display the nodes of the mesh.

Select the mesh in the study tree, then left click in the 3D window and 
select:

Display Mode → Nodes

78. Change the size of nodes.

Always  in  the  3D window,  left  click  and  select  “Color/Size”,  then 
change the “Scale” for “1”.

79. Display the group “wing”.

In the study tree, left click on the group “wing” and select “Show”.

80. Look in the   O  xy   direction  , deactivate the axis display as in the 
“Geometry” module and zoom close to the wing.

81. Change the center of rotation of the 3D window   for one of the   
nodes of the mesh.

Click on the “Change Rotation Point” icon  of the 3D window's 

toolbar, then unselect “Use Bounding Box Center”,  click on “Select 
Point from View” and click on a node, then click on “Close”.

Warning: Don't hesitate to redo this action each time you think it  
will help you manipulate the 3D window.

82. Zoom very   close to the   intermediate edges to see the generated   
nodes.

83. Check if the nodes are distributed in the right direction.

84. Edit the hypothesis “Inter” to add some revered edges.

Left click on “Inter” in the study tree under “Hypotheses”, and select  
“Edit Hypothesis”.

Then, click on edges in the 3D window so that they become white, and 
add  them  in  the  “Reversed  Edges”  by  clicking  on  “Add”  in  the 
“Hypothesis Construction” window.

Warning: The selection of reversed edges can be difficult. Don't  
hesitate to strongly zoom on edges before selecting them  
and to use selection boxes.
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Warning: After  adding an edge in the “Reversed Edges”,  click  
anywhere in the 3D window before starting a new edge  
selection.

Adding  reversed  edges  is  necessary  in  the  case  of  a  wrong  node 
distribution  direction.  If  all  the  nodes  are  OK,  just  remove  all  the 
“Reversed Edges” before clicking “OK” or “Cancel” your hypothesis 
modification.

85. Create a sub-mesh associated to the group “Trans”

86. Add  to  this  sub-mesh an  algorithm  of  type  “Wire 
discretisation”  using  a  hypothesis  of  type  “Nb.  Segment” 
having 10 segments and an “Equidistant distribution”.

Warning: Don't forget to rename each sub-mesh and hypothesis  
with  the  same name than the  associated  group.  This  
permits to find easily a hypothesis or a sub-mesh in the  
study tree for later modifications.

87. Generate the mesh “Mesh_1” and check if   all is OK  .

88. Create a sub-mesh associated to the group “LongUp”, using a 
algorithm of  type  “Wire  discretisation”  and  a  hypothesis  of 
type “Nb. Segment” having 50 segments.

89. Change  the  “Type  of  distribution”  of  the  hypothesis  for 
“Distribution with table density”.

90. Enlarge the “Hypothesis Construction” window so as to well 
see the density table.

91. Add two rows to the density table.

Use the button “Insert row”.

92. Fill the density table as following:

t f(t)

1 0 1

2 0.5 0.5

3 1 2
 

93. Generate the mesh and check if everything is OK.

94. Create another  sub-mesh  associated  with  the  group 
“LongDown”  with  the  same  characteristics  excepted  the 
density table:

t f(t)

1 0 2

2 0.5 0.5

3 1 1
 

95. Generate the mesh and check if everything is OK.

Now, all the 1D discretization of the prismatic layer edges are done.
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96. Create a sub-mesh associated with the group “PL”

97. Add to this  sub-mesh  a 2D algorithm of  type “Quadrangle 
(Mapping)”.

In the “Create sub-mesh” window, click on the tab “2D” and change 
the “Algorithm” for  “Quadrangle (Mapping)”.

98. Generate the mesh.

99. Display the faces of   the mesh in shading mode  .

Select the mesh in the study tree, then left click in the 3D window and 
select:

Display Entity → Faces

Then, do it again and select:

Display Mode → Shading

100. Check everything is OK.

Warning: Sometimes, little parasite edges appear in the mesh. To  
make sure an edge is a parasite edge, click on it and see  
if it disappears.

We will now add a new 3D algorithm for the prismatic layer volumes.

101. Expand the object “Mesh_1” and “SubMeshes on Compound” 
in the study tree.

102. Add a 3D algorithm of type “Hexahedron (i,j,k)” to the sub-
mesh associated with the prismatic layer volumes.

Left  click  on  the  sub-mesh  icon  in  the  study tree  and  select  “Edit 
Mesh/Sub-mesh”, then in the “3D” tab, change the “Algorithm” for 
“Hexahedron (i,j,k)” and click on “Apply and Close”.

103. Generate the mesh.

104. Hide the faces of the mesh.

Select the mesh in the study tree, then left click in the 3D window and 
select:

Display Entity → Faces

105. Display the volumes of the mesh.

Select the mesh in the study tree, then left click in the 3D window and 
select:

Display Entity → Volumes

106. Check everything is OK in the 3D window.

Now, the prismatic layer is entirely meshed.

107. Hide the volumes of the mesh.
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II.2.2  Domain Meshing

108. Create a sub-mesh   associated to the group “MainFront”.  

109. Add to this sub-mesh an algorithm “Netgen 1D-2D”.

110. Add to this  algorithm  a  hypothesis    of  type “NETGEN 2D   
Parameters” having a max size of 2, a very fine “Fineness” and 
without optimization.

In the “Hypothesis Construction” window, change the “Max. Size” for 
“2”,  the “Fineness” for “Very Fine” and unselect “Optimize”.

111. Generate the mesh.

112. Display the faces of the mesh.

113. Check if everything is OK.

At this stage, the mesh is not very beautiful because the optimization 
was deactiveted to save time.

114. Edit the hypothesis to activate the optimization and generate 
the mesh. 

Now, the mesh generation is a little bit longer.

The 2D mesh of the front side of the domain will now be projected on 
the back face. To do so, the nodes of the source face have first to be 
projected on the target face.

115. Create a sub-mesh   associated to the group “FarfBack”  .

116. Add to this sub-mesh an algorithm “Projection 1D”.

117. Add to this  algorithm  a  hypothesis    of  type “Source  Edge”   
having the group “FarfFront” as a source edge and the mesh 
“Mesh_1” as a source mesh.

Once in the  “Hypothesis Construction” window, click on the group 
“FarfFront” in the study tree so as to make it appear in the field “Edge” 
of the window, then click on the arrow button of the window in front of 
“Mesh” and left  click somewhere on the mesh appearing in the 3D 
window to make its name appear in the “Mesh” field of the window. 
Then click on “OK”.

118. Create a sub-mesh   associated to the group “MainBack”  .

119. Add to this sub-mesh an algorithm “Projection 2D”.

120. Add to  this  algorithm  a  hypothesis    of  type  “Source  Face”   
having the group “MainFront” as a source edge and the mesh 
“Mesh_1” as a source mesh.

121. Generate the mesh and check if everything is OK.

Now all the faces are meshed excepted the farfield face.

122. Create a sub-mesh   associated to the group “FarfTrans”  .

123. Add to this sub-mesh an algorithm “Wire discretisation”.
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124. Add to this algorithm  a hypothesis of type “Nb. Segments” 
having only one segment.

Keep the default values in the “Hypothesis Construction” window.

125. Create a sub-mesh   associated to the group “farfield”  .

126. Add to this sub-mesh an algorithm “Quadrangle (Mapping)”.

127. Generate the mesh and check if everything is OK  .  

All the faces are now meshed. It it then necessary to fill the rest of the  
domain with an unstructured mesh.

128. Edit the mesh “Mesh_1”.

In the study tree, left click on the object “Mesh_1” and select “Edit  
Mesh/Sub-mesh”.

129. Add to this mesh a 3D algorithm “Tetrahedron (Netgen)”.

130. Generate the mesh.

This step can take a very long time.

131. Hide the faces of the mesh and  display the volumes of the 
mesh.

Displaying  the  volumes  can  take  a  lot  of  computer  resources,  but 
allows to be sure the volumes were all generated.

132. Check if everything is OK.

133. Hide the volumes of the mesh.

The 3D mesh is now finished. Before exporting it, it is nevertheless 
necessary to add to this mesh the groups that will be used by Edge 
during computation.

II.2.3  Group Adding

134. Open the “Create Group” window   from the mesh object  .

Left click on the mesh object in the study tree (“Mesh_1”) and select 
“Create Group”.

135. Select the face mode.

Select “Face” in the  “Create Group” window.

136. Select the “Group on geometry” mode.

137. Create  the  mesh  group associated  to  the  geometrical  group 
“wing”.

Click on the arrow button in front of “Geometrical Object” and select 
the group “wing” in the study tree, then click on “Apply”.

138. Create the mesh groups associated to the geometrical groups 
“front”, “back” and “farfield”.

139. Expand the object “Groups of Faces” under the mesh object 
“Mesh_1” so as to make visible the created groups.
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140. Display  each of these groups separately and check if there is 
no problem.

The mesh is now completely finished and ready to be exported into a 
.amsh file.

II.2.4  Mesh Export

141. Load the “vzlu.py” script.

142. Export the mesh in a file called “nacaTutorial.amsh”.

In the Python console, type:

amsh(“nacaTutorial”)

This step can take a long time.

After that, the mesh should be available in the home folder of the user. 
He or she can from now start an Edge computation from this mesh 
after having converted it into a .bmsh file thanks to the shell command:

ffaa2b nacaTutorial.amsh Edge.bmsh

After the user started the computation, it is then possible to generate 
the jBAY file which will  be used for the computation taking under 
consideration the presence of vortex generators.

II.3  Generation of the jBAY File

II.3.1  Vortex Generator's Vane Creation

143. Return to the “Geometry” module.

By clicking on .

For convenience, we will now create a new study in which only the 
wing surface will be imported.

144. Export the group “wing” into a .brep file named “wing”.

145. Create a new study.

146. Load the “Geometry” module.

147. Import the “wing.brep” file.

148. Expand the object “Geometry” in the study tree.

149. Look in the O  xy   direction   and deactivate the axis display.

150. Create a point having the coordinates (0,0,0).

151. Create three other points having the coordinates (  0.025  ,0,0),  
(0.025,  0.008  ,0), and (  0.02  ,0.008,0)  .

152. Create four edges linking these four points, as illustrate below.
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New Entity → Build → Edge

Then, select the points “Vertex_1” and “Vertex_2” in the study tree and 
click on “Apply”. After that, select directly the “Vertex_3” and click on 
“Apply”. Redo it with the “Vertex_4” and finally the “Vertex_1”.

153. Create a face from these edges.

Select all the edges in the study tree or in the 3D window, then:

New Entity → Build → Face

and click on “Apply and Close”.

The face “Face_1” is our vortex generator's vane model. We will now 
give to it a distance and an angle of attack.

II.3.2  Vortex Generator Vane Positioning

154. Load the “vzlu.py” script.

155. Transform the vane “Face_1” into a counter-rotating pair of 
vane  having  a  trailing  edge  distance  of  0.02  meters  and an 
angle of attack of 20  º  .

In the Python console, type:

pov(0.02,20)

We will now position the vanes in the Ozx plane at 0.6% of the chord.

156. Translate the pair of vanes at   x   = 0.6 meters  .

Select “pair of vanes from Face_1 ...” in the study tree, then:

Opertation → Transformation → Translation

then change “Dx” for “0.6” and click on “Apply and Close”.

We will now project the vanes on the upper side if the wing.

157. Explode the wing (“wing.brep_1”) into two faces.

158. Expand the wing object in the study tree so as to make visible 
the exploded faces.
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159. Rename the upper face “upperFace”.

In the study tree, select the face “Face_...” corresponding to the upper 
face of the wing and type [F2] or left click on it and select “Rename” 
to change its name.

160. Project the pair of vane on the upper face of the wing.

In the Python console, type:

pow(“Translation_1”,”upperFace”)

161. Expand the object “projected vanes from Translation_1” in the 
study tree.

The projected vanes “vane0” and “vane1” are now in the study tree as  
separated faces. We will now generate the jBAY file from these two 
vanes, even if it is possible to generate this file from only one vane or 
more that two.

As  we  will  use  these  two  vanes,  we  will  first  unite  them  into  a  
“Compound” that will be given to the jBAY function.

II.3.3  Generation of the jBAY File

162. Create a compound object containing the two projected vanes.

Select the both vanes “vane0” and “vane1”, then:

New Entity → Build → Compound

163. Generate the  jBAY file  from the  compound  object  and the 
upper wing surface.

In the Python console, type:

jbay(“Compound_1”,”upperFace”)

The file Edge.avg should be now available in the user's home folder. 
The user can now use it in Edge.
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III The Use of pl( ): Explanation
This part's aim is to well explain how to prepare an .igs file describing an airfoil to be used with the 
pl( ) command of the script vzlu.py creating prismatic layer geometries around airfoils. Indeed, this  
command was especially designed to work with .igs files generated with the tool JavaFoil9, which 
is not always true.

As an example, this part gives the procedure followed to create a classical .igs file. Then, it explains 
the possibilities of the pl( ) command for airfoils created by other means.

III.1  Example of JavaFoil Use in the Context of the Use of pl( )

III.1.1  The Original Data

The data used to make the airfoil utilized in the vortex generator model validation study was given 
in a document from NASA10 in the following way:

(…)

Illustration 12: GA(W) -1 airfoil point coordinates given in the NASA's document “Development of a Fowler Flap 
System for a High Performance General Aviation Airfoil”.

One can see that the figures were displayed in two parts, each of which referring to the upper side 
or the lower side of the airfoil, and each  beginning from the point (0,0,0) to a point close to (1,0,0).

III.1.2  Point Coordinate Preparation in Open Office Spreadsheet

So, all these figures were copied in an Open Office spreadsheet. Then, the format of the cells were 
modified to make appear in each of them a big number of decimal places, as shown in the next 
picture.

9 See ref. 7 (page 13).
10 Wentz, W. H., Seetharam, H. C., “Development of a Fowler Flap System for a High Performance General Aviation 

Airfoil”, NASA, Washington D. C., December 1974, p. 23.
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III The Use of pl( ): Explanation - Example of JavaFoil Use in the Context of the Use of pl( )

      

Illustration 13: Good figure display in Open Office Spreadsheet before using JavaFoil.

This was a way to avoid the presence of figures without comma (e.g. “0” instead of “0.0”), which 
are not recommended in JavaFoil.

III.1.3  The Use of JavaFoil

Then, the “Coordinates” window of JavaFoil was totally emptied and filled with the upper side 
point coordinates  only, copied from the Open Office spreadsheet. After that, the button “Update 
View” was activated to make appear the upper side of the GA(W)-1 airfoil in the JavaFoil 2D 
window, as shown in the next picture.

Illustration 14: Upper surface of the GA(W)-1 airfoil display in JavaFoil.

Once this was done, and only at this moment, the lower side point coordinates were copied and past 
under the point coordinates already present in the “Coordinates” window of JavaFoil, and then the 
button “Update View” was activated again. By doing this, JavaFoil automatically reordered the 
points so that they described a curve starting from and finishing at the trailing edge of the airfoil.
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III The Use of pl( ): Explanation - Example of JavaFoil Use in the Context of the Use of pl( )

Illustration 15: Full GA(W)-1 airfoil display in JavaFoil.

Then, the .igs file  was generated by clicking on “Save...” and by entering in the field “Enter file 
name” the name “gaw1.igs”.  By this way, the .igs file imported in Salome worked perfectly with 
the command pl( ) from the script given in the annex  Error: Reference source not found of this 
document.

III.2  The Use of pl( ) in Other Cases
Let see now how to do in the case that the airfoil is not imported from an .igs file created with  
JavaFoil.

III.2.1  The Classical pl( ) Input

III.2.1.1  Imported .igs Airfoils from JavaFoil: a Set of Edges

Actually, an .igs file created with JavaFoil and imported in Salome consists in a  wire  containing 
several  little  edges.  In Salome,  wires are order-ed ensembles of edges,  which are fundamental 
geometrical objects as vertexes or faces. These little edges are represented in the following picture, 
showing the ones contained in a wire representing a NACA airfoil imported from JavaFoil.

Illustration 16: Edges contained in a Salome wire resulting of the import of an .igs file created with JavaFoil.

Unfortunately, having such a set of edges is not acceptable because this arbitrary discretization has 
a big influence on the meshing step. Indeed, the ends of these edges are necessary associated with 
nodes during the mesh generation. And, some meshing conditions as the ones imposing a number 
of divisions on each edge (and not on each wire) would have a very limited interest in this case.

III.2.1.2  The Airfoil Reconstruction

That's why the first step of the pl( ) command is to fuse these little edges into bigger edges, better  
representative of the airfoil's structure (upper side, lower side, etc.). To do so, it first detects edges 
having a high relative angle so as to sort them into different sections, which are reconstructed as 
new edges using their end points. The user can also create a discontinuity in these new edges by 
imposing the end of an original edge as a “startPoint”, as illustrated in the following picture11.

11 To have more information about the use of a “startPoint”, type “help(pl)” in the Python console of Salome after 
having importing the script vzlu.py or see the part II.1.2 of the tutorial given in the part II, page 15.

33



III The Use of pl( ): Explanation - The Use of pl( ) in Other Cases

Illustration 17: An airfoil discretized in edges by pl( ) in Salome.

Then, the ends of these new edges are considered to be start points of  intermediate edges which 
link the airfoil with the airfoil offset representing the contour of the prismatic layer, as visible in the 
next picture. These intermediate edges can then be used to create the prismatic layer surfaces or 
volumes and to be associated with meshing conditions.

Illustration 18: Offset and intermediate edges (black lines) built by the command pl( ) in Salome.

III.2.2  The Other Way to Use pl( )

But it is possible that the airfoil is not an imported .igs file created thanks to JavaFoil. And, some 
cases can happen in which the direct use of the command pl( ) doesn't work, especially when the 
edges representing the airfoil are too big, making the reconstructed edges too much rough or not 
permitting to well position the start points of the intermediate edges, or when the whole airfoil is 
represented by a single edge. 

In this case, the user has to make him or herself the reconstruction of the airfoil in several edges, as  
in the picture 17 (previous page), and to include these edges in a wire,  by selecting them and by 
clicking on New Entity → Build → Wire in the menu bar, and then on “Apply and Close”. Then, the 
wire can be used with  a pl( ) function at the condition that the argument “fuse” is changed to 
“False” as in the example below:

pl(0.02,”Wire_1”,fuse=False)

So, to construct these edges, the user can have to make two kinds of operation: edge split or edge 
fusion. Let's see how to proceed.

III.2.2.1  The Edge Split

The edge split is necessary if, for example, the whole airfoil is described by one single edge. To 
split it, the user can use the basic tools of Salome. For example, one can make a “Partition” of the 
edge to split thanks to points laying on it.

To do so, the user has just to create new vertexes on this edge by selecting it and by clicking in the  
menu bar of Salome on New Entity → Basic → Point, and then by using the positioning on a curve 

 in the “Point Construction” window. Then, the user can split the edge thanks to a “Partition”  

by clicking in the menu bar, after having selected the edge to split, on Operations → Partition, and 
then by clicking on the button “Tool Objects”, by selecting the splitting point(s), by changing the 
“Resulting Type” for “Edge” and by finally clicking on “Apply and Close”.
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III The Use of pl( ): Explanation - The Use of pl( ) in Other Cases

The object created thanks to this action is a compound object (named, for example, “Partition_1”) 
containing the split edges. To get back these edges, the user has to “Explode” this compound object 
by selecting it and by clicking in the menu bar on New Entity → Explode, then by changing “Sub 
Shapes Type” for “Edge” and by clicking on “Apply and Close”.  The user can then see the split 
edges under the compound object in the study tree.

III.2.2.2  The Edge Fuse

In the case of edge fuse, no Salome tool exists to do so. That's why a function named edge( ) was 
implemented  in  the  script  given  in  the  annex  Error:  Reference  source  not  found,  allowing  to 
transform a wire containing several edges into a single edge. Unlike the pl( ) function, which just 
uses the end points of the edges contained in a wire to rebuild bigger edges, this command cuts  
each edge of the concerned wire into a lot of vertexes used to reconstruct the final edge. So, the 
length of the edges contained in the wire to fuse doesn't matter.

To use this command, it  is only necessary to build a wire containing all the edges to fuse (by 
selecting all the concerned edges, then by selecting in the menu bar of Salome New Entity → Build 
→ Wire, and by clicking on “Apply and Close”), and to type in the Python console, in the case that 
this wire is called “Wire_1”:

edge(”Wire_1”)

Once all the edges of the airfoil are built, the user can put them into a final wire which can be used 
in a pl( ) command as explained in the introduction of this chapter (previous page).
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Annex 1 JBAY file example
This annex consists in an example of jBAY input file corresponding to the simulation of a pair of 
counter-rotating vanes, each described by three points, normals and heights.

VGENDATA N 0 0 1 
      region N 0 0 1 
            VGENCONFIG N 0 0 2 
                  VGEN N 0 0 4 
                        coord DI 3 3 0 
                              0.4765732923549187      0.4940379925796018      0.4999999999999999 
                              0.0940454938393463      0.1007599145773721      0.0922909975051880 
                              -0.0135505035831417      -0.0073941410032797      -0.0050000000000000 
                        norm DI 3 3 0 
                              0.1762589596830368      0.1682486688579085      0.1479497115812030 
                              2.1947440623596868      2.1765227621225254      2.1307768330985413 
                              0.0000002000000000      0.0000002000000000      0.0000002000000000 
                        height DI 1 3 0 
                              0.0000002989761942      0.0079743211114762      0.0079999186194165 
                        g_param DI 1 2 0 
                              0.5000000000000000      0.5000000000000000 
                  VGEN N 0 0 4 
                        coord DI 3 3 0 
                              0.4765732923549187      0.4940379925796018      0.4999999999999999 
                              0.0940454938393463      0.1007599145773721      0.0922909975051880 
                              0.0135505035831417      0.0073941410032797      0.0050000000000000 
                        norm DI 3 3 0 
                              0.1762589596830368      0.1682486688579085      0.1479497115812030 
                              2.1947440623596868      2.1765227621225254      2.1307768330985413 
                              0.0000002000000000      0.0000002000000000      0.0000002000000000 
                        height DI 1 3 0 
                              0.0000002989761942      0.0079743211114762      0.0079999186194165 
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Annex 2 RANS file example
This annex consists in an example of RANS input file corresponding to  the simulation, for a 2D 
calculation, of a counter-rotating pair of vanes.

VGENDATA N 0 0 1 
       region N 0 0 1 
            VGENCONFIG N 0 0 1 
                  RANS-VGEN N 0 0 17 
                        ninterwall I 1 1 0 
                              0 
                        npoint I 1 1 0 
                              64 
                        nperiod I 1 1 0 
                              20 
                        ncolloc I 1 1 0 
                              10 
                        heightscale DI 1 1 0 
                              4.000000 
                        r0 DI 1 1 0 
                              0.100000 
                        c0 DI 1 1 0 
                              3.192782 
                        c1 DI 1 1 0 
                              1.000000 
                        alphal DI 1 1 0 
                              16.700000 
                        alphar DI 1 1 0 
                              -16.700000 
                        dist DI 1 1 0 
                              7.322835 
                        delta DI 1 1 0 
                              3.327953 
                        dvector DI 3 1 0 
                              1.000000 
                              0.000000 
                              0.0 
                        coord DI 3 1 0 
                              0.600000 
                              0.093710 
                              0.0
                        norm DI 3 1 0 
                              0.101873 
                              0.764581 
                              0.0 
                        height DI 1 1 0 
                              0.007620 
                        g_params DI 1 2 0 
                              0.5      0.5
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